TRAC PAC 2

BRIDGE BUILDER

ABSTRACT

This module addresses comprehensive aspects of the design and building of bridge structures.
Numerous concepts are introduced independently and then they are synthesized through a series
of experimental demonstrations, hands-on projects, and computer-based simulations.

Activity 1 is an interactive computer-based introduction to the basic concepts employed by the
structural engineer when designing and building bridges. The students will first examine the
main challenge facing a bridge designer, which is the identification of the different types of loads
that a bridge must be capable of withstanding. Specifically, they will be taught the following
concepts:

e Dead Load (weight of the structure itself)
e Live Load (weight of anything on the bridge, including cars, people, and snow)
e Other Loads (including earthquake forces and stresses due to temperature fluctuations)

Then, the module will address the types of forces that bridge elements must withstand (tension,
compression, and bending) and ways different materials (concrete, wood, and steel) are suited to
withstand each type of force.

After this introduction has been presented, students will begin to study the different types of
bridges (suspension, girder, arch, and truss) and the factors that go into deciding the most
suitable type of structure for a given location. Then, they will look at the individual building
blocks (connections, cables, columns, beams, arches and struts) that make up each type of
bridge. Specifically, each of these elements will be discussed in terms of the forces to which they
will be subjected and appropriate materials for their construction. Online demonstrations
illustrate these points.

Activity 2 involves in-class demonstrations that illustrate some of the key structural concepts that
are essential to understanding how basic bridges behave. Students can see how the efficiency of a
simple structure is affected by its basic geometry.

Activity 3 gives the students an introduction to computer-based design. The Model Smart
program allows them to design computational bridge models that can be used to predict overall
structure strength and weight. This program allows the students to define the bridge geometry,
choose the material properties, and apply different loading situations. After designing the bridge,
a computational analysis can be performed that shows the students how their models deformed
and failed under the given loading state.
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Activities 4 and 5 allow the students to take part in hands-on activities that guide them through
the process of building their own bridges, which they will test in class as part of a design
competition. The judging of each student-built structure will be based upon the overall weight of
the structure and its performance, which will be measured by applying incremental loads to the
structure until it fails.
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TEACHER REFERENCE

This section includes the module introduction, student handouts, answers to all questions posed
in the activities, and a description of the education standards covered by each of the activities.
The Activities Section which follows this Teacher's Reference Section contains in-depth
descriptions of each activity.
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Introduction

Engineering is not simply about solving problems. It is about solving problems in the
most efficient and elegant manner possible and not creating new problems along the way.
In order to come up with the most efficient solution, some amount of prior knowledge is
usually needed. Frequently, this knowledge is mathematical or experiential.

For centuries, scientists, mathematicians and engineers have studied the physical world
and recorded their observations. They have derived mathematical formulas that describe
the way materials and systems behave. And they have conducted experiments and drawn
conclusions from their results. This body of knowledge that has accumulated over time is
what engineers study and apply to solve problems everyday. This process is what
differentiates engineering from tinkering.

Tinkering is what we do when we try to solve problems by relying on trial-and-error.
Tinkering can be fun, but it is usually not the most efficient way of solving a problem.
And although solutions to engineering problems can sometimes be found by tinkering,
these solutions tend to be neither efficient nor optimal.

Engineering can be fun, too. There is a great deal of satisfaction to be gained from approaching a
problem theoretically. Typically, an engineer will try to find a set of equations that describe the
problem mathematically. These equations will then give the engineer clues about how to solve
the problem at hand. Using these clues, engineers can arrive at the optimal solution much quicker
than they could have if they had relied on tinkering alone.

Many of the activities in this module relate the real-world problem of constructing a bridge to the
mathematical equations that have been derived to describe the behavior of simple beams.
Activities 2A through 2C demonstrate how mathematics accurately predicts the behavior of
simple wooden beams, and Activity 3 shows how a mathematics-based computer program can be
an effective tool in designing a bridge.
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Student Handouts

This section includes activity handouts and blank activity questions for students. All handouts
may be photocopied for use in the classroom. Suggested answers to student activity questions
are provided in the Teacher.
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Name: Date:

ACTIVITIES 2A, 2B, AND 2C:
BEAM ME UP

The wooden beams constructed in this activity approximate what is called a simply-supported
beam. For such a beam, the maximum vertical deflection, v, at the midspan can be
mathematically described by the following equation:

PL’
V =
AEbK®

where P is the magnitude of the force applied at the midspan, E is the elastic modulus of the
beam material, L is the length of the beam, b is the width of the beam, and 4 is the height of the
beam. It is important to note here that / is not the distance of the beam above the ground, it is the
height of the beam itself — measured from the bottom of the beam to the top of the beam.

ACTIVITY 2A — BASIC BALSA: EFFECT OF
BEAM LENGTH

QUESTIONS

1) Which piece broke more easily, the 24" piece or the 12" piece? Why do you suppose this
occurred?

2) How much greater was the maximum deflection of the 24" piece than that of the 12" inch
piece? How does this compare to the predicted value?
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3) If you were going to try the experiment again with a 48" long piece of balsa wood, how much
bending would you expect to see? How about with a 6" long piece?

DISCUSSION
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ACTIVITY 2B — LAMINATION: INCREASE BASE
WIDTH

QUESTIONS

1) How did the 12" laminated balsa beam perform compared to the single 12” piece of balsa?
Why?

2) How much less was the maximum deflection of the laminated beam than that of the 12" inch
piece alone? How does this compare to the predicted value?

3) If you were going to try the experiment again with a laminated beam made of three 12" long
pieces of balsa wood glued together side-by-side, how much bending would you expect to
see?

DISCUSSION
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ACTIVITY 2C — LAMINATION: INCREASE
HEIGHT

QUESTIONS

1) How did the 12" laminated beam perform compared to the single 12" piece of balsa? Why?

2) How much less was the maximum deflection of the laminated beam than that of the 12" inch
piece alone? How does this compare to the predicted value?

3) How much less was the maximum deflection of the double-height laminated beam than that
of the double-width laminated beam? How does this compare to the predicted value?
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4) If you were going to try the experiment again with a laminated beam made of three 12" long
pieces of balsa wood glued on top of each other, how much bending would you expect to
see?

DISCUSSION
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Name: Date:

ACTIVITY 3: COMPUTER-
BASED BRIDGE MODELING

Breaking Load Structure Weight | Performance Ratio*

Basic Balsa

Advanced: Redesign 1

Advanced: Redesign 2

* Divide the Breaking Load by the reported structure weight of Basic Box structure to obtain the
performance ratio.

QUESTION

While experimenting with the Advanced Structure, did you notice any particular design
attributes that contribute to the amount of weigh the structure was able to support? What design
aspects resulted in high performance ratios?

DISCUSSION
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Name: Date:

ACTIVITY 4: BASIC BOX
BRIDGE STRUCTURE

QUESTIONS

1) Tabulate a list of each bridge's weight, ultimate strength and performance ratio, and compare
the construction and performance of each structure tested. Do you notice any particular
design attributes that contribute to the structure's sturdiness? For instance, did using a lot of
glue help the bridge support more weight? Did it increase the performance ratio?

2) How did your structure break? Did it break from shearing (i.e., did the end-plate of the bolt
simply snap though the pieces below it)? Twisting? Rotation? Joint failure? Why do you
think your structure broke in the manner that it did?
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3) How do you think you can improve the design of the basic box to make it bear more weight?
How do you think you can improve the design of the basic box to achieve a greater
performance ratio?

DISCUSSION
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Name: Date:

ACTIVITY 5;: IMPROVED BOX
BRIDGE STRUCTURE

QUESTIONS

1) Tabulate a list of each bridge's weight, ultimate strength, and performance ratio and compare
the design, construction, and performance of each structure tested. Do you notice any
particular design attributes that contribute to the amount of weight the structure was able to
support? What design aspects resulted in high performance ratios?

2) How did your structure break? Did it break from shearing? Twisting? Rotation? Joint failure?
Why do you think your structure broke in the manner it did?
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3) How do you think you can improve the design to make it bear more weight? How do you
think you can improve the design of the basic box to achieve a greater performance ratio?

DISCUSSION
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Answers to Questions

This section includes answers to the questions found in the Student Handouts. Also,
included are discussion points for each activity that the teacher may want to review prior
to presenting the material.
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Teacher's Copy

ANSWERS TO QUESTIONS

ACTIVITIES 2A, 2B, AND 2C:
BEAM ME UP

ACTIVITY 2A — BASIC BALSA: EFFECT OF
BEAM LENGTH

QUESTIONS

1) Which piece broke more easily, the 24" piece or the 12" piece? Why do you suppose this
occurred?

The 24" piece should have broken at a lesser load. This is because the deflection increases as the
length of the beam is increased.

2) How much greater was the maximum deflection of the 24" piece than that of the 12" inch
piece? How does this compare to the predicted value?

Theory predicts that the deflection of the 24" piece should be 8 times greater than the deflection
of the 12" piece under the same load. This is because the deflection is directly proportional to
the cubed value of the length. So doubling the length increases the deflection by 2° = 8 times.

3) If you were going to try the experiment again with a 48" long piece of balsa wood, how much
bending would you expect to see? How about with a 6" long piece?

Using the same reasoning as the answer for the previous guestion, the 48" piece should deflect 8
times more than the 24" piece, while the 6" piece should only deflect 1/8 as much as the 12"

piece.

DISCUSSION
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The bending equation assumes that the material properties of the beam are known and precise. In
reality, the wood may contain flaws such as micro cracks that are not readily visible. These
cracks could cause the wood to bend excessively or break prematurely. These flaws are not
predicted by the bending equation. Was there evidence of this in the students' experiments?

It should be noted here that the engineer rarely gets to choose the length of a bridge; it is usually
dictated by the size of the feature (road, river, or gorge) that the bridge has to span.
Consequently, length is usually considered to be a given variable, and controlling the deflection
of the bridge is a matter of designing the other two geometric parameters (height and width)
accordingly. The effect of these other geometric parameters will be observed in the following
two demonstrations.

ACTIVITY 2B — LAMINATION: INCREASE BASE
WIDTH

QUESTIONS

1) How did the 12" laminated balsa beam perform compared to the single 12" piece of balsa?
Why?

The laminated piece should have broken at a greater load. This is because the deflection
decreases as the width of the beam is increased.

2) How much less was the maximum deflection of the laminated beam than that of the 12" inch
piece alone? How does this compare to the predicted value?

Theory predicts that the deflection of the double-wide laminated piece should be half as great as
the deflection of the single piece alone under the same load. This is because the deflection is
inversely proportional to the width. So doubling the width decreases the deflection by 21=>
times.

3) If you were going to try the experiment again with a laminated beam made of three 12" long
pieces of balsa wood glued together side-by-side, how much bending would you expect to see?

Using the same reasoning as the answer for the previous question, the three-piece-wide beam
should deflect one third as much as the single piece alone and two thirds as much as the double-

wide piece.

DISCUSSION

The bending equation assumes that the material properties of the beam are known and precise. In
reality, the wood may contain flaws such as micro cracks that are not readily visible. These
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cracks could cause the wood to bend excessively or break prematurely. These flaws are not
predicted by the bending equation. Was there evidence of this in the students' experiments?

Ask the students to consider how the beams would behave if they were merely placed next to
each other and not glued together.

It should be noted here that the width of the bridge may be dictated by the number of lanes of
traffic it must support. Consequently, width may be considered to be a given variable, and

controlling the deflection of the bridge is frequently a matter of designing the height accordingly.
The effect of the beam height will be observed in the next demonstration.

ACTIVITY 2C — LAMINATION: INCREASE
HEIGHT

QUESTIONS

1) How did the 12" laminated beam perform compared to the single 12" piece of balsa? Why?

The laminated piece should have broken at a lesser load. This is because the deflection
decreases as the height of the beam is increased.

2) How much less was the maximum deflection of the laminated beam than that of the 12" inch
piece alone? How does this compare to the predicted value?

Theory predicts that the deflection of the laminated piece should be 8 times less than the
deflection of the single piece under the same load. This is because the deflection is inversely
proportional to the cubed value of the height. So doubling the height decreases the deflection by
2% = 8 times.

3) How much less was the maximum deflection of the double-height laminated beam than that of
the double-width laminated beam? How does this compare to the predicted value?

The double-height beam should deflect only 1/4 as much as the double-width beam. This is
because the deflection is inversely proportional to the width, but is inversely proportional to the
cubed value of the height. This is an important point, because the performance of the double-
height beam is significantly better than that of the double-wide beam even though the same
amount of material is being used.

3) If you were going to try the experiment again with a laminated beam made of three 12" long
pieces of balsa wood glued on top of each other, how much bending would you expect to see?
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Using the same reasoning as the answer to Question 2, the triple-height piece should deflect 27
times less than the single piece. Because the deflection is inversely proportional to the cubed
value of the height, tripling the height decreases the deflection by 3° = 27 times.

DISCUSSION

The bending equation assumes that the material properties of the beam are known and precise. In
reality, the wood may contain flaws such as micro cracks that are not readily visible. These
cracks could cause the wood to bend excessively or break prematurely. These flaws are not
predicted by the bending equation. Was there evidence of this in the students' experiments?

The students should take the knowledge gained from these experiments and apply them to the
structures they will build in the next sections. It is hoped that they will realize that for maximum
effectiveness it is better to have a rectangular beam oriented so that it is taller rather than wider
when subjected to a vertically applied load.
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Teacher's Copy

ANSWERS TO QUESTIONS

ACTIVITY 3;: COMPUTER-
BASED BRIDGE MODELING

QUESTIONS

1. While experimenting with the Advanced Structure, did you notice any particular design
attributes that contribute to the amount of weight the structure was able to support? What design
aspects resulted in high performance ratios?

The inclusion of diagonal elements (instead of vertical members alone) should greatly improve
the performance ratio of the structure. Including laminated elements (doubling the height of the
individual members) on the bottom of the structure should also increase the structure's strength.
The students will probably also identify other enhancements to the basic model that they can
share with the rest of the class.

DISCUSSION:

By experimenting with the program, students can try out different configurations and analyze the
results much more readily then they could if they had to build the structures physically. In a
relatively short amount of time, sophisticated insight can be gained regarding what factors
contribute to making the bridge both strong and efficient.

Ideally, the students will design their structures with the Model Smart program and then build the
structures with the balsa wood and glue. It will be fascinating for them to see how well the
computer model predicted the performance of their physical bridges. If the actual structure
performance and the model results do not correlate, ask them to suggest why this may be. The
answer probably lies in the construction of the actual bridge. The factors outlined in Activity 4
may contribute to detrimental performance.
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Teacher's Copy

ANSWERS TO QUESTIONS

ACTIVITY 4: BASIC BOX
BRIDGE STRUCTURE

QUESTIONS

1) Tabulate a list of each bridge's weight, ultimate strength and performance ratio, and compare
the construction and performance of each structure tested. Do you notice any particular
design attributes that contribute to the structure's sturdiness? For instance, did using a lot of
glue help the bridge support more weight? Did it increase the performance ratio?

The amount of glue at a joint can impact the performance of the structure. Not enough glue can
result in premature failure at a joint, while too much glue can adversely add to the structure
weight which lessens the performance ratio. Finding the optimal amount of glue can be a key to
success.

Careful construction can greatly increase performance. Incorrect measurements or imprecise
cutting or gluing can result in the structure being warped. A warped structure is inherently more
susceptible to failing quickly due to twisting.

2) How did your structure break? Did it break from shearing (i.e., did the end-plate of the bolt
simply snap though the pieces below it)? Twisting? Rotation? Joint failure? Why do you
think your structure broke in the manner that it did?

If the structure twisted or rotated, it probably did so because either it was warped or else the
load was applied off-center. If the joint failed, it may have not had a sufficient amount of glue. A
shearing failure generally means that the structure was well-built. A structure that breaks due to
shearing should have a good performance ratio. However, shearing may also be the result of a
flaw in the wood (such as a small crack).

3) How do you think you can improve the design of the basic box to make it bear more weight?
How do you think you can improve the design of the basic box to achieve a greater
performance ratio?

Generally there are four good ways to improve the basic box structure:
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1. Include diagonal support elements on the sides of the bridge, instead of only vertical
ones.

2. Include diagonal elements on the top and bottom of the bridge to resist twisting

3. Make the structure taller to take advantage of the relationship between the structure's
deflection and its height (see Activity 2C).

4. Pay more attention to careful construction techniques.

DISCUSSION:

Students who used a lot of glue may notice that their bridges were stronger. But they may also
notice that their performance ratios suffered from the added weight to the structure. Try to
identify any structures that failed because the joints were improperly glued. Compare the
performance of these structures to those that had heavily glued joints. It is important to find the
middle ground between a structure with strong joints and a structure with a light weight.

Some students who constructed well-built bridges may have had disappointing results because of
the existence of unseen flaws (such as cracks or pin holes) in their wood. When handing out the
wood for the next activity, give the students the opportunity to examine their wood and replace
any faulty pieces with unflawed wood.

If any of the designs were warped, the students may notice that their bridge twisted apart rather
than broke in two by shearing. This type of failure may be avoided by ensuring the wood is cut to
the proper lengths and glued together at right angles. Also, if the end plate of the U-bolt was not
centered properly on top of the structure, an eccentric loading may result which can cause
twisting. Allowing the students to place the testing bolt on their own structures will make them
more aware of this possibility.

Some ways that the students can alter their design to achieve better results are discussed in
Activity 5.
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Teacher's Copy

ANSWERS TO QUESTIONS

ACTIVITY 5;: IMPROVED BOX
BRIDGE STRUCTURE

QUESTIONS

1) Tabulate a list of each bridge's weight, ultimate strength, and performance ratio and compare
the design, construction and performance of each structure tested. Do you notice any particular
design attributes that contribute to the amount of weigh the structure was able to support? What
design aspects resulted in high performance ratios?

See the answer to Question 1 of Activity 4.

2) How did your structure break? Did it break from shearing? Twisting? Rotation? Joint failure?
Why do you think your structure broke in the manner that it did?

See the answer to Question 2 of Activity 4.

3) How do you think you can improve the design to make it bear more weight? How do you
think you can improve the design of the basic box to achieve a greater performance ratio?

See the answer to Question 3 of Activity 4.

DISCUSSION:

Students who used a lot of glue may notice that their bridges were stronger. But they may also
notice that their performance ratios suffered from the added weight to the structure. Try to
identify any structures that failed because the joints were improperly glued. Compare the
performance of these structures to those that had heavily glued joints. It is important to find the
middle ground between a structure with strong joints and a structure with a light weight.

Some students who constructed well-built bridges may have had disappointing results because of
the existence of unseen flaws (such as cracks or pin holes) in their wood. When handing out the
wood for the next activity give the students the opportunity to examine their wood and replace
any faulty pieces with unflawed wood.
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If any of the designs were warped, the students may notice that their bridge twisted apart rather
than broke in two by shearing. This type of failure may be avoided by ensuring the wood is cut to
the proper lengths and glued together at right angles. Also, if the end plate of the U-bolt was not
centered properly on top of the structure, an eccentric loading may result which can cause
twisting. Allowing the students to place the testing bolt on their own structures will make them
more aware of this possibility.
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National Education Standards

NATIONAL SCIENCE EDUCATION STANDARDS: PHYSICAL
SCIENCE

Grades 5-8 and Grades 9-12

Science as Inquiry

Identify questions that can be answered through scientific investigations.

Use appropriate tools and techniques to gather, analyze, and interpret data.

Use technology and mathematics to improve investigations and communications.
Think critically and logically to make the relationships between evidence and
explanations.

Abilities of Technological Design

Identify appropriate problems for technological design.
Design a product

Implement a proposed design

Evaluate completed technological designs or products.

NATIONAL EDUCATIONAL TECHNOLOGY STANDARDS FOR
ALL STUDENTS

Basic operations and concepts

Technology problem-solving and decision-making tools

¢ Students use technology resources for solving problems and making informed decisions.
e Students employ technology in the development of strategies for solving problems in the
real world.
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STANDARDS FOR TECHNOLOGICAL LITERACY FOR THE
INTERNATIONAL TECHNOLOGY EDUCATION ASSOCIATION

Design

e Students will understand role of trouble shooting, research and development, invention
and innovation and experimentation in problem solving.

The Designed World
e Students will be able to select and use construction technologies.
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ACTIVITIES

This section includes in-depth activity descriptions, questions and discussion points. All
answers to questions and student handouts are given in the Teacher's Reference section.
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Activity Overview Table

. . e Technology National Science & Technology Transportation
Grade Level Activity Description Level Education Standards Background Material Page
Science Standards
Science as inquiry
Identify problems for technological
design
Introductory activity Design a product
Grades 8-12: designed to introduce Implement proposed design
Intermediate and High students to basic concept of Evaluate product
School Activity 1: bridge design including i Structural engineering
Structural Concepts | types of loads, forces Technology Standards and design
Beginner bridge bridges must withstand, and Basic operations and concepts
building materials that can withstand Technology problem-solving and
these forces. decision-making tools
Standards for Technological
Literacy
Design
The Designed World
Science Standards
A load is applied to various Science as inquiry
Activity 2A : configurations of balsa Identify problems for technological
wood strips and the students design
Grades 8-12 . ;
Basic Balsa: Effect observe how the geometry Design a product . .
. Structural engineering
- . of Beam Length (length) affects the amount Lo Implement proposed design .
Beginning Bridge . and design
e of deflection and the Evaluate product
Building . .
Hands-on OR ultimate failure load. .
. Standards for Technological
Demonstration Li
iteracy
Design
The Designed World
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- e Technology National Science & Technology Transportation
Grade Level Activity Description Level Education Standards Background Material Page
Science Standards
Science as inquiry
Activity 2B. A load is applied to various Ideptlfy problems for technological
Grades 8-12 Lamin;;ion'. configurations of balsa design
Increase Ba'se Width wood srips and the students Design a product i Structural engineerin
Beginning Brid observe how the geometry Lo Implement proposed design o dosian g g
Bi%l ding & £° Hands-on OR (beam width) affects the Evaluate product &
amount of deflection and the Standards for Technological
Demonstration ultimate failure load. Literacy
Design
The Designed World
Science Standards
A load is applied to various Smenpe as mquiry .
Activity 2C configurations of balsa ldeptlfy problems for technological
d ctivity =% wood strips and the students design
Grades 8-12 Lamination: h Design a product
I Heicht observe how the geometry ) Structural enci .
Beginnine Brid nerease Heig (beam height) affects the Lo Implement proposed design an?fiesria nengmeermg
Bzﬁtinillllzlg rege Hands-on amount of deflection and the Evaluate product g
OR . ultimate failure load. Standards for Technological
Demonstration Literacy
Concept: }
Design
The Designed World
Students use the Model ) Science Standards
Smart software application Smenpe as mquiry .
to design computer-based Ideptlfy problems for technological
Grades 8-12 Activity 3: bridge models, using the demgn
Computer-Based same design concepts used Hi Design a product ' Structural eneineerin
Beginnine Bridee Bridge Modeling everyday by structural Implement proposed design angl deusi R g g
Bu%l ding & brdg engineers using advanced Evaluate product &

finite element programs to
design bridges.

Standards for Technological
Literacy
Design
The Designed World
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tested in the classroom by
applying a load at the
midspan until the structure
breaks.

Standards for Technological
Literacy

Design
The Designed World

- . Technology National Science & Technology Transportation
Grade Level Activity Description Level Education Standards Background Material Page
Science Standards

Students construct a Science as inquiry

rectangular box out of balsa Identify problems for technological

wood and glue. After design
Grades §-12 Activity 4 the sruetures il be tested. Design a product

cuviy s . Implement proposed design Structural engineering
. . Basic Box Bridge in the classroom by Lo .

Beginning Bridge S Ivi load at th Evaluate product and design
Building tructure ap.p ying a (?a at the

midspan until the structure Standards for Technological

breaks. Literacy

Design
The Designed World

Similar to activity 4,

Students construct a .

rectangular box bridge out Science Standards

of balsa wood and glue. In Science as inquiry

the advanced lesson, depth Identify problems for technological

of bridge and other design
Grades 8-12 Activity 5: structural parameters are left Design a product

I ¢ }é d ’BO open to the student to design Lo Implement proposed design Structural engineering

Beginning Bridge BrrrlﬁirOeVStruct):lr within certain limitations. Evaluate product and design
Building & © Finished products will be
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Activity 1: Structural
Concepts

ACTIVITY TABLE

Teacher Prep Time 10 minutes reading

Class Time 30 minutes

Grade/Class 8-12 Beginner

Technology Hi Tech

. . . Science as inquiry

National Science Education Standards Identify problems for technological design
Design a product
Implement proposed design
Evaluate product

INTRODUCTION

This activity may be presented as either a presentation or a hands-on interactive experience for
the individual student. This interactive computer-based introduction describes some basic
concepts employed by the structural engineer when designing and building bridges.

OBJECTIVE

The presentation first examines the main challenge facing a bridge designer, which is the
identification of the different types of loads a bridge must be capable of withstanding.
Specifically, the students will be taught the following concepts:

e Dead Load (weight of the structure itself)
e Live Load (weight of anything on the bridge, including cars, people, and snow)
e Other Loads (including earthquake forces and stresses due to temperature fluctuations)

Then, the module addresses the types of forces that bridge elements must withstand (tension,
compression and bending) and how different materials (concrete, wood, and steel) are suited to
withstand each type of force.
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After this introduction has been presented, students will begin to study the different types of
bridges (suspension, girder, arch, and truss) and the factors that go into deciding the most
suitable type of structure for a given location. Then, they will look at the individual building
blocks (connections, cables, columns, beams, arches, and struts) that make up each type of
bridge. Specifically, each of these elements will be discussed in terms of the forces to which they
will be subjected and the appropriate materials are for their construction. Online demonstrations
illustrate these points.
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Bridge Builder
Activities 2a, 2b, and 2c:
Beam Me Up

ACTIVITY TABLE

Teacher Prep Time 10 minutes reading; 20 minutes lab prep

Class Time 30 minutes

Grade/Class 10-12 Beginner

Technology Lo Tech

. . . Science as inquiry

National Science Education Standards Identify problems for technological design
Design a product
Implement proposed design
Evaluate product

INTRODUCTION

This activity may be presented as either a demonstration or hands-on lab to illustrate the
geometric parameters that affect the bending behavior of beams and bridges. A load is applied to
various configurations of balsa wood strips, and the students observe how the geometry (length,
width, and height) affects the amount of deflection ( or the movement of a structure resulting
from stress) and the ultimate failure load.

OBJECTIVE

In these experiments, the students will observe the following:

- Doubling the length of the beam results in an eight-fold increase in the amount of
weight the beam deflects (Activity 24),

- Doubling the base width of the beam results in an two-fold decrease in the amount of
weight the beam deflects (Activity 2B), and
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- Doubling the height of the beam results in an eight-fold decrease in the amount of
weight the beam deflects (Activity 2C).

Thus, the students will learn that an efficient use of the wood can lead to drastically improved
bending performance.

BACKGROUND

It is a common practice to introduce students to bridge behavior by first studying how simple
beams behave when they are subjected to applied loads. The purpose of these in-class
demonstrations is to teach students how the basic geometric parameters (length, width, and
height) affect the deflection response and ultimate strength of a simple beam.

For the purposes of these demonstrations, the instructor will use balsa wood strips to make
simple beams with rectangular cross-sections. (Students will later use the same material to build
their own model bridge structures.) The exact geometric proportions of the beams will vary to
suit the objectives of each of the three demonstrations, described in the following section.

For each demonstration, the instructor will bend the beam by applying a force at its midspan. The
beam should be situated so that each of its ends rests on an elevated surface (such as an edge of a
desk). The force will be applied by hanging a bucket on the beam and gradually filling it with
measured amounts of sand. The instructor will record the displacement of the center of the beam
with a ruler.

This configuration approximates what is called a simply-supported beam. For such a beam, the
maximum vertical deflection, v, at the midspan can be mathematically described by the
following equation:

rr’
V=—"—"+
4Ebh®

where P is the magnitude of the force applied at the midspan, E is the elastic modulus of the
beam material, L is the length of the beam, b is the width of the beam, and 4 is the height of the
beam. It is important to note here that /4 is not the distance of the beam above the ground, it is the
height of the beam itself — measured from the bottom of the beam to the top of the beam.

From this equation, we can see that the beam will deflect a greater amount if the length is
increased or either the width or height is decreased. However, it should be noted that changing
the length or height of the beam will not result in a directly proportional change in the deflection
of the beam because each of these parameters are cubed. This will become evident to the
students when they witness the following demonstrations.
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MATERIALS

Three (3) 36" lengths of 1/8" square cross-section balsa wood

One S-hook

Light plastic painter's bucket
Play sand

Measuring cup (1/4-cup)
X-Acto Knife

12" Ruler (or Meter stick)

Weighing Scale

ACTIVITY 2A — BASIC BALSA: EFFECT OF

BEAM LENGTH

The purpose of this experiment is for the students to learn that doubling the length of the beam
results in an eight-fold increase in the amount of weight the beam deflects. The behavior of the
differing lengths will be observed by testing each of these simple beams individually and then

comparing the results.

SET UP

As shown in Figure 1, the instructor
should take a single piece of 36" balsa
wood and divide it into two pieces with
the X-Acto knife — one piece should be
24", the other 12". The behavior of the
differing lengths will be observed by
testing each of these simple beams
individually and then comparing the
results.

PROCEDURE

[

12“"0%

24 inches

Not to scale.

Figure 1. Cut 36" balsa wood strip into two pieces as
shown.
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For a given cross-section, the deflection of a beam at any given value of applied load is directly
proportional to the cubed value of the length. In this experiment you will be testing two beams of
identical cross-section: one beam will be twice as long as the other. Thus, theory predicts that the
deflection of the shorter beam will be one-eighth as great as the deflection of the longer beam
under the same load.

The following steps roughly outline the basic testing procedure that the instructor should follow
for each of the in-class demonstrations.

Part L.

1. Place the 24" long beam between two end supports, so that 2" of the wood is resting
on each support. Two low desktops spaced the appropriate distance apart make good
end supports.

2. Hook one end of the S-hook around the wooden beam, so that it is in the center
(midspan) of the beam.

3. Hook the empty plastic bucket to the other end of the S-hook. The setup should now
appear as in Figure 2. Note that for this length of balsa wood, the bucket itself may
cause a severe enough deflection to break the wood. If so, proceed directly to Step 10.

4. Place a vertically-oriented ruler alongside the beam at its midspan. This may best be
accomplished by securing a meter stick to a ring-stand.

5. The sand will be added to the bucket in “4-cup increments.

6. After pouring a quarter of a cup of sand into the bucket, note the corresponding
deflection of the center of the beam for the applied load.

7. Continue observing the scale and adding sand in 1/4—cup increments into the bucket

until the wood breaks. Another member of the class should be standing by waiting to
catch the bucket when the wood fails.

Support spaciW

Support spacing: 20 in.

(a) 24 in. beam (b) 12 in. beam

Figure 2. Basic Setup for testing of 24" and 12" lengths of balsa wood.
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8. Continue observing the amount of deflection and pouring sand into the bucket until
the wood breaks.

9. Record the last observed deflection immediately prior to the wood breaking.

10. Using the scale, weigh the bucket, its contents, and the S-hook. Record this number.
Keep the sand in the bucket. You will need it for the next part of the experiment.

11. Now, place the 12" long beam between the two end supports, so that 1" of the wood
is resting on each support.

12. Hook one end of the S-hook around the wooden beam, so that it is in the center
(midspan) of the beam.

13. Hook the plastic bucket with the sand in it to the other end of the S-hook.

14.  Place a vertically oriented ruler alongside the beam at its midspan, and measure the
displacement of the 12" beam.

15.  After pouring an additional "4-cup of sand into the bucket, note the corresponding
deflection of the center of the beam for the applied load.

16.  Continue observing the scale and adding sand in “4-cup increments into the bucket
until the wood breaks.

17.  Record the final observed deflection immediately prior to the wood breaking.

18. Using the scale, weigh the bucket, its contents, and the S-hook. Record this number.

QUESTIONS

1) Which piece broke more easily, the 24" piece or the 12" piece? Why do you suppose this
occurred?

2) How much greater was the maximum deflection of the 24" piece than that of the 12" inch
piece? How does this compare to the predicted value?
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3) If you were going to try the experiment again with a 48" long piece of balsa wood, how much
bending would you expect to see? How about with a 6" long piece?

DISCUSSION

The bending equation assumes that the material properties of the beam are known and precise. In
reality, the wood may contain flaws such as micro cracks that are not readily visible. These
cracks could cause the wood to bend excessively or break prematurely. These flaws are not
predicted by the bending equation. Was there evidence of this in the students' experiments?

It should be noted here that the engineer rarely gets to choose the length of a bridge; it is usually
dictated by the size of the feature (road, river or gorge) that the bridge has to span. Consequently,
length is usually considered to be a given variable, and controlling the deflection of the bridge is
a matter of designing the other two geometric parameters (height and width) accordingly. The
effect of these other geometric parameters will be observed in the following two demonstrations.

ACTIVITY 2B — LAMINATION: INCREASE BASE
WIDTH

The purpose of this experiment is for the students to observe that doubling the base width of the
beam results in half the amount of deflection. The behavior of two beams with differing widths
will be observed by testing each of the beams individually and then comparing the results.

SET UP
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The instructor should take a 36" long piece of balsa wood and cut it into three 12" long pieces.
Two of the 12” pieces of balsa should be glued together lengthwise, so that the whole 12”
surface of the first piece is layered against the whole 12” surface of the second piece (as shown
in Figure 3). This technique is called “lamination.” The glue should be allowed to dry for the
recommended period of time. (It may be more efficient to prepare the laminated pieces before
class.)

PROCEDURE

For a beam with a given length and height, the deflection at any given value of applied load is
inversely proportional to the width of the beam. In this experiment you will be testing two beams
of equal lengths and heights: one beam will be twice as wide as the other. Thus, theory predicts
that the deflection of the wider beam will be one-half as great as the deflection of the narrower
beam under the same load.

The following steps outline the basic testing procedure for each of the in-class demonstrations.

1. Place the 12" long 12 inches "
unlaminated beam between sy
two end supports, so that 1”
of the wood is resting on each
support. Two desk tops
spaced the appropriate
distance apart make good end
supports (see Figure 3).

12 inches

12 inches

2. Hook one end of the S-hook
around the wooden beam, so
that it is in the center
(midspan) of the beam.

3. Hook the empty plastic e
bucket to the other end of the o aaeces
S-hook. The setup should
now appear as in Figure 2a

from Activity 2a. Figure 3. Cut 36" balsa wood strip into three pieces as

shown, and glue two pieces together along long edge.

4. Place a vertically oriented
ruler alongside the beam at its midspan.

5. The sand will be added to the bucket in %-cup increments.

6. After pouring a Y4-cup of sand into the bucket, note the corresponding deflection of
the center of the beam for the applied load.

Bridge Builder Module--Activities 41



TRAC PAC 2

7.

10.

11.

12.

13.

14.

15.

16.

17.

Continue observing the scale and adding sand in Y4-cup increments into the bucket
until the wood breaks. Another member of the class should be standing by waiting to
catch the bucket when the wood fails.

Record the last observed deflection immediately prior to the wood breaking.

Using the scale, weigh the bucket, its contents, and the S-hook. Record this number.
Keep the sand in the bucket. You will need it for the next part of the experiment.

When the laminated piece has dried, it can be placed on the end supports, so that 1" of
the wood is resting on each support. The lamination should be oriented so that it is
situated horizontally; that is, the layered pieces of wood should be next to each other
(not on top of each other).

Hook one end of the S-hook around the laminated beam, so that it is in the center
(midspan) of the beam.

Hook the plastic bucket with
the sand in it to the other end of
the S-hook. The setup should
now appear as in Figure 4.

Support spacing: 10 in.

Place a vertically oriented ruler
alongside the beam at its

midspan, and measure the 47
displacement of the 12" beam.

After pouring an additional Y4-
cup of sand into the bucket,
note the corresponding
deflection of the center of the beam for the applied load.

Figure 4. Setup for testing of the double-wide
laminated 12" long beam.

Continue observing the scale and adding sand in Y4-cup increments into the bucket
until the wood breaks.

Record the last observed deflection immediately prior to the wood breaking.

Using the scale, weigh the bucket, its contents, and the S-hook. Record this number.

QUESTIONS

1) How did the 12" laminated balsa beam perform compared to the single 12" piece of balsa?

Why?
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2) How much less was the maximum deflection of the laminated beam than that of the 12" inch
piece alone? How does this compare to the predicted value?

3) If you were going to try the experiment again with a laminated beam made of three 12" long
pieces of balsa wood glued together side-by-side, how much bending would you expect to
see?

DISCUSSION

The bending equation assumes that the material properties of the beam are known and precise. In
reality, the wood may contain flaws such as micro cracks that are not readily visible. These
cracks could cause the wood to bend excessively or break prematurely. These flaws are not
predicted by the bending equation. Was there evidence of this in the students' experiments?

Ask the students to consider how the beams would behave if they were merely placed next to
each other and not glued together.

It should be noted here that the width of the bridge may be dictated by the number of lanes of
traffic is must support. Consequently, width may be considered to be a given variable, and
controlling the deflection of the bridge is frequently a matter of designing the height accordingly.
The effect of the beam height will be observed in the next demonstration.
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ACTIVITY 2C — LAMINATION: INCREASE
HEIGHT

The purpose of this experiment is to observe that doubling the height of the beam results in only
one-eighth the amount of deflection. The behavior of two beams with differing heights will be
observed by testing each of the beams individually and then comparing the results.

SET UP

The instructor should take a 36" long piece o
of balsa wood and cut it into three 12" 12inches
long pieces. Two of the 12" pieces of balsa S
should be glued together lengthwise, so
that the whole 12" surface of the first piece
is stacked on top of the whole 12" surface
of the second piece (as shown in Figure 5).
This technique is called ”lamination.” The
glue should be allowed to dry for the
recommended period of time. (It may be
more efficient to prepare the laminated
pieces before class.)

12 inches

12 inches

PROCEDURE »Zo7 3

Glue two pieces on

: . : top of each other.
For a beam with a given length and width, op ot each oher

the deflection at any given value of
applied load is inversely proportional to Figure 5. Cut 36" balsa wood strip into three pieces as
the cubed value of the height of the beam. shown, and glue two pieces on top of each other.

In this experiment you will be testing two beams of equal lengths and widths: one beam will be
twice as tall as the other. Thus, theory predicts that the deflection of the taller beam will be one-
eighth as great as the deflection of the shorter beam under the same load.

The following steps outline the basic testing procedure that the instructor should follow for each
of the in-class demonstrations.

1. Place the 12" long unlaminated beam between two end supports, so that 1" of the
wood is resting on each support. Two desktops spaced the appropriate distance apart
make good end supports.

2. Hook one end of the S-hook around the wooden beam, so that it is in the center
(midspan) of the beam.
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3.

10.

11.

12.

13.

14.

15.

16.

17.

Hook the empty plastic bucket to the other end of the S-hook. The setup should now
appear as in Figure 2a in Activity 2a.

Place a vertically oriented ruler alongside the beam at its midspan.
The sand will be added to the bucket in Y-cup increments.

After pouring a “4-cup of sand into the bucket, note the corresponding deflection of
the center of the beam for the applied load.

Continue observing the scale and adding sand in 1/4—cup increments into the bucket
until the wood breaks. Another member of the class should be standing by waiting to
catch the bucket when the wood fails.

Record the final observed deflection immediately prior to the wood breaking.

Using the scale, weigh the bucket, its contents, and the S-hook. Record this number.
Keep the sand in the bucket. You will need it for the next part of the experiment.

When the laminated piece has dried, it can be placed on the end supports, so that 1" of
the wood is resting on each support. The lamination should be oriented so that it is
situated vertically; that is, the layered pieces of wood should be on top of each other
(not next to each other).

Hook one end of the S-hook around the laminated beam, so that it is in the center
(midspan) of the beam.

Hook the plastic bucket with
the sand in it to the other end of
the S-hook. The setup should
now appear as in Figure 6.

Support spacing: 10 in.

Place a vertically oriented ruler
alongside the beam at its

midspan, and measure the 4~
displacement of the 12" beam.

After pouring an additional 4-
cup of sand into the bucket,
note the corresponding
deflection of the center of the beam for the applied load.

Figure 6. Setup for testing of the double-height
laminated 12" long beam.

Continue observing the scale and adding sand in Y4-cup increments into the bucket
until the wood breaks.

Record the last observed deflection immediately prior to the wood breaking.

Using the scale, weigh the bucket, its contents, and the S-hook. Record this number.

Bridge Builder Module--Activities 45



TRAC PAC 2

QUESTIONS

1) How did the 12” laminated beam perform compared to the single 12 piece of balsa? Why?

2) How much less was the maximum deflection of the laminated beam than that of the 12" inch
piece alone? How does this compare to the predicted value?

3) How much less was the maximum deflection of the double-height laminated beam than that
of the double-width laminated beam? How does this compare to the predicted value?

4) If you were going to try the experiment again with a laminated beam made of three 12" long
pieces of balsa wood glued on top of each other, how much bending would you expect to
see?
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DISCUSSION

The bending equation assumes that the material properties of the beam are known and precise. In
reality, the wood may contain flaws such as micro cracks that are not readily visible. These
cracks could cause the wood to bend excessively or break prematurely. These flaws are not
predicted by the bending equation. Was there evidence of this in the students' experiments?

The students should take the knowledge gained from these experiments and apply them to the
structures they will build in the next sections. It is hoped that they will realize that for maximum
effectiveness it is better to have a rectangular beam oriented so that it is taller rather than wider
when subjected to a vertically applied load.
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Activity 3: Computer-Based
Bridge Modeling

ACTIVITY TABLE
Teacher Prep Time 10 minutes reading; 30 minutes software use
Class Time 30 minutes
Grade/Class 8-12 Beginner
Technology Hi Tech
. . . Science as inquiry
National Science Education Standards Identify problems for technological design
Design a product
Implement proposed design
Evaluate product

INTRODUCTION

Students will use the Model Smart software application to design computer-based two-
dimensional bridge models. This software is unique in that it allows the students to specify balsa
wood as a structural material. Consequently, they can perform this activity prior to building the
structures described in Activities 4 and 5 to predict their structure's performance.

The modeling concepts they will learn are the same as those used everyday by structural
engineers using advanced finite element programs to design bridges.

OBJECTIVE

The students will learn how the computer can be used as an effective tool for predicting
structural performance.

BACKGROUND

Constructing a virtual model entails implementing the following steps with the chosen software
application:
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1.

Define the structure geometrically. Node points are specified that represent each joint of
the structure, and then elements are defined that connect the node points and represent the
beam sections.

Define the material properties of the elements. The cross-sections of the beams are
defined and the beam material is specified (such as balsa wood or steel).

. Define the displacement constraints. The nodes representing the ends of the structure are

fixed so that they cannot displace. These constraints represent the physical barrier
imposed on the structure by the fulcrum points.

Apply virtual loads. After the structure is defined, the forces acting on it must be
specified. For instance, to approximate the loading condition used in the testing of the
physical models (described above) a vertical force acting downward on the software
model at its midspan should be applied.

Run the model. Activate the software's computational mechanism to calculate the
behavior (displacement, ultimate strength, etc.) of the model under the applied loading.

After the students have constructed and analyzed the performance of their initial models, they
can tweak the design of their structures and see how the changes affect the overall behavior of
the structure.

MINIMUM MATERIALS NEEDED:

Macintosh or Power Macintosh with "13" color monitor, System 7.0, § MB RAM, 5 MB
Hard Drive Space

or

IBM Compatible 80486 PC with 16 color VGA monitor, 8 MB RAM, Microsoft
Compatible Mouse, Windows 3.1 (with win32s extensions)

And

Model Smart software, version 1.62 (Pre-Engineering Software Corporation) — included.

SET UP

It is recommended that the students be allowed to use this software individually or in groups of
no more than two. In addition to this tutorial, there is an example in the software manual that
may be beneficial to the instructor and the students.
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PROCEDURE

This activity may have the most learning potential if the students are allowed to exercise their
own imagination in designing their structures. However, the procedure outlined below steps them
through the process of designing the basic box structure described in Activity 4. Additionally,
some modifications are then added that will illustrate the utility of the software and the
effectiveness of some advanced design topics discussed in Activity 5.

BASIC BOX STRUCTURE

1. Launch the ModelSmart program and click on the About screen to start the program.

2. Choose a sheet size. Click on the File menu item, select New and then choose
30"x20" (as shown in Figure 7). This will provide adequate space to build the model,
which is 20" long and 2" tall.

EMudEISmalt ¥1.62 - Untitled

File Display Supports  Members  Joints Loads  Analysis  Help

150" |
Open...
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Export as JPG..

Exit - ModelSmart
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Z L & a2 10 1z 14 1 1z z0 ZEZ z4 Z6 z8 in

Figure 7. Selection of sheet size.

3. Choose a default material type. Click on the Members menu and choose Default
Material Type. From the list given, choose Balsa Wood and then 1/8" Balsa-
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BALA4DI. This corresponds to the material used to construct the structures in
Activities 3 and 4.

4. Add members.
a. Click on the Members menu item and check Add (if it is not already checked).

b. Itisa good idea to draw the longest member in the bridge first to help establish
the origin and ensure that the model does not extend past the limits of the
workspace. Consequently, the first member drawn will be the bottom
longitudinal beam. Locate the coordinate point corresponding to x = 5 inches and
vy = 10 inches. This coordinate will be designated as (5,10). Click on this point and
drag the cursor (without releasing the mouse) to (25,10). You will see that the first
element has been drawn. It is 20 inches long, as shown in Figure 8. A member
consists of a tan-colored element and two joints (blue circles) on either end. If you
make a mistake, you can erase the member by choosing Delete from the Members
menu, then clicking on the incorrectly drawn element. You will probably have to
erase the joints as well by choosing Delete from the Joints menu and then clicking
on the errant joints.

[E2 ModelSmart ¥1.62 - Untitled =] B3

File Display  Supports Memberz  Jointz  Loads  Analpsiz Help

Z0

1s

1le

14

1z

T T T T T T T T T T T T T T T
z 4 & s 10 1z 14 16 1B 20 ZE z4 Z6 Z8 in.

Figure 8. Bottom beam element.

d. Draw the top beam by clicking on (5,12) and dragging the cursor to (25,12).
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e. Draw the first vertical member by clicking on (5,10) and dragging the cursor to
(5,12).

f. Continue adding the remaining four vertical members by drawing members from
(10,10) to (10,12), (15,10) to (15,12), (20,10) to (20,12), and (25,10) to (25,12).
The completed structure is shown if Figure 9.

EHUdeISmall ¥1.62 - C:\My Documents\TRAC PAC\basic_balsa_intro.msd
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Figure 9. Basic box structure.

5. Add supports. The bridge must be constrained to ensure that it doesn't float away
when a load is applied to it. Two supports are going to be added which will represent
the effect of the desktops upon which the balsa wood model is placed when being
tested.

a. From the Supports menu, choose Add Hinge.
b. Click once on the bottom left hand corner of the bridge — coordinate (5,10).
c. From the Supports menu, choose Add Horizontal Roller.

d. Click once on the bottom right hand corner of the bridge — coordinate (25,10).

6. Apply a load. A load is going to be applied to the bridge that will correspond to the
force supplied by the U-bolt bracket in Activities 3 and 4.

Bridge Builder Module--Activities 52



TRAC PAC 2

a. Choose Vertical Down from the Loads menu.

b. Click on the joint in the middle of the bridge on the top beam - coordinate (15,12).
The complete structure with end supports and applied force is shown in Figure 10.

7. Analyze the structure.

a. Click on the Analyze menu, select Analysis Options, and make sure that Show
Displacement and Show Bent Members are chosen.

b. Click on Analyze under the Analyze menu. The model is then run. The vertical
load is incrementally increased and you will see the bridge deform.

c. After the analysis has been run, the Breaking Load and the Structure weight are
reported at the top of the page. Record these numbers. The screen should now
appear as shown in Figure 11.

d. To see how the bridge will break, click on the Analyze menu, select Analysis
Options, and choose Show Collapse and Show Bent Members.

e. Click on Analyze under the Analyze menu. The model is then run. The vertical
load is incrementally increased and you will see the bridge deform then break
apart.

EMudEISmalt ¥1.62 - C:AMy DocumentzATRAC PACAbasic_balza_intro.msd
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Figure 10. Complete structure with end supports and applied force.
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EMDdeISmalt ¥1.62 - C:AMy Documents\TRAC PACAbasic_balza_complete.mzd
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Figure 11. The deformed basic box structure.

f. Divide the Breaking Load by the reported structure weight of Basic Box structure.
This will be known as the bridge's performance ratio.

g. Save your model.

ADVANCED STRUCTURE

The basic box is not the most efficient structure that can be designed with the given materials.
Well chosen diagonal elements can greatly increase the overall performance of the bridge.
Ideally, the students should experiment with the ModelSmart program (by adding or modifying
elements) to see how the system behavior changes with each new design. Some sample
modifications are described below:

Redesign 1

a. Open the model you created for the Basic Box exercise.

b. From the Joints menu, choose Delete.
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c. Click on the top left-most joint (5,12) and the top, right-most joint (25,12) to delete them.
The members that intersect at these joints will also disappear.

d. From the Members menu, choose Add.

e. Draw a new diagonal member on the left-hand side of the structure by clicking on (5,10)
and dragging the cursor to (10,12).

f. Draw a new diagonal member on the right-hand side of the structure by clicking on
(25,10) and dragging the cursor to (20,12). Your model should now appear as the one
shown in Figure 12.

g. Click on the Analyze menu, select Analysis Options, and make sure that Show
Displacement and Show Bent Members are chosen.

h. Click on Analyze under the Analyze menu. The model is then run. The vertical load is
incrementally increased and you will see the bridge deform.

i. After the analysis has been run, the Breaking Load and the Structure weight are reported
at the top of the page. Record these numbers and compare them to the numbers for the
basic box.

j. Divide the Breaking Load by the reported structure weight of Basic Box structure to
calculate the bridge's performance ratio. How does it compare to the performance of the

EMndeISmart ¥1.62 - C:\My DocumentsA\TRAC PAC\basic_balza_5-21_msd
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Figure 12. The structure for Redesign 1.
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basic box?
k. Save this model as a new file.
Redesign 2
a. Open the previous model.
b. From the Members menu, choose Add.

c. Draw a new interior diagonal member on the left-hand side of the structure by clicking
on (10,12) and dragging the cursor to (15,10).

d. Draw a new interior diagonal member on the right-hand side of the structure by clicking
on (20,12) and dragging the cursor to (15,10). Your model should now appear as the one
shown in Figure 13.

e. Click on the Analyze menu, select Analysis Options, and make sure that Show
Displacement and Show Bent Members are chosen.

f. Click on Analyze under the Analyze menu. The model is then run. The vertical load is
incrementally increased and you will see the bridge deform.

g. After the analysis has been run, the Breaking Load and the Structure weight are reported

EMndeISmart ¥1.62 - C:\My DocumentsiTRAC PA[Z\hasic_halsa_ck:nplete_msd
File Display Supportz Members Joints Loads Analysis Help
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Figure 13. The structure for Redesign 2.
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at the top of the page. Record these numbers and compare them to the numbers for the
basic box and the previous model.

h. Divide the Breaking Load by the reported structure weight of Basic Box structure to
calculate the bridge's performance ratio. How does it compare to the performance of the
basic box and the previous model?

QUESTION

While experimenting with the Advanced Structure, did you notice any particular design
attributes that contribute to the amount of weigh the structure was able to support? What design
aspects resulted in high performance ratios?

DISCUSSION:

By experimenting with the program, students can try out different configurations and analyze the
results much more readily then they could if they had to build the structures physically. In a
relatively short amount of time, sophisticated insight can be gained regarding what factors
contribute to making the bridge both strong and efficient.

Ideally, the students will design their structures with the ModelSmart program and then build
3-D structures based on these designs with the balsa wood and glue. To build the 3-D structures
the students will construct two identical 2-D frames using their ModelSmart design. Then they
will connect the two frames together with pieces of wood that act as lateral bracing. It will be
fascinating for them to see how well the computer model predicted the performance of their
physical bridges. If the actual structure performance and the model results do not correlate, ask
them to suggest why this may be. The answer probably lies in the construction of the actual
bridge and/or the effect of the lateral bracing which is not accounted for in the ModelSmart
program. The factors outlined in Activity 4 may contribute to detrimental performance.
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Activity 4: Basic Box Bridge
Structure

ACTIVITY TABLE

Teacher Prep Time 10 minutes reading; 20 minutes lab prep

Class Time 1 hour 30 minutes

Grade/Class 8-12 Beginner

Technology Lo Tech

. . . Science as inquiry

National Science Education Standards Identify problems for technological design
Design a product
Implement proposed design
Evaluate product

INTRODUCTION

In this hands-on activity, the students will construct a rectangular box out of balsa wood and
glue. Each student (or group of students) will design the same structure with the dimensions
specified in Figure 14.

After building the models, each of the structures will be tested in the classroom by applying a
load at the midspan until the structure breaks.
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20”

Cross-Sections not drawn to scale.

Figure 14. Dimensions of Basic Box structure.
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OBJECTIVE

The objective is for the students to learn basic drafting and construction techniques and to
observe how the structure's performance is affected by:

1. The quality of construction (especially the joints),
2. The presence of possible defects in the balsa wood, and
3. Any loading eccentricity.

The lessons learned in building this basic structure will aid the students in designing the
advanced structure described in Activity 5.

* An instructor who wants to conduct only one bridge building exercise, should skip this activity
and use Activity 5, instead. However, prior to starting Activity 5, it would be a good idea to read
through this activity for background material.

BACKGROUND

The building of a bridge is composed of two main components: the designing (and planning) of
the bridge and the building (or construction) of the bridge. The design of the bridge determines
the general structure type and the geometric layout of its members to ensure an efficient and safe
design for a given loading condition (which is also called the service state). The contractors will
then take the engineering/architecture plans and actually build the structure.

When designing the bridge, the engineer assumes that the material properties are known, proper
construction techniques will be employed, and the bridge will be mainly used to support loads
that will act downward on the road surface. However, the engineer is also wise enough to know
that things can go wrong. Consequently, safety factors are used when designing structures.

This activity will help students identify some of the things that can go wrong in the construction
and testing phase of their bridge model, so that they can learn from their mistakes when
constructing the advanced model.

MATERIALS NEEDED:

Four (4) 36" lengths of 1/8" square cross-section balsa wood
Carpenter's Glue
X-Acto Knife

Ruler or straight edge
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Long Pins

Drafting (or Graph) Paper — at least 22" long by 8"
Wax paper — same dimensions as drafting paper

4" long and 2.25" wide U-bolt with bracket and nuts
Light plastic painter's bucket

2.5 quart measuring pail

Play sand

Weighing scale

Safety goggles

SET UP

The instructor will need to allocate the wood, glue, pins, X-Acto knives, straight edges, wax
paper, and drafting paper to the students or groups of students. The provided draft paper is only
17 inches long, so in lieu of other supplies, students could tape 2 sheets together to ensure a 1:1
scale. It is recommended that group sizes be limited to no more than 3 students. The rest of the
materials will be used for the in-class testing.

PROCEDURE

Drafting Exercise

Given the dimensions in Figure 14, the students should draw planar (two-dimensional) views of
the structure they are going to build. The gradations on the drafting (or graph) paper will help
them ensure that the lines representing the structural elements are drawn to the correct 1:1 scale.
Generally, students may want to draw two side views and one end view of the structure. A
sample side and end view are shown in Figure 15.
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Figure 15. Sample side view and end view of basic box structure.

Construction Exercise

Note: Students should wear safety goggles while cutting the balsa wood, and care should be taken so
that they do not cut themselves with the X-Acto knife.

1.

The students should cut each of the balsa wood lengths into eleven pieces — one 20"
length, nine 1.75" lengths, and one 0.25" length (which can be discarded).

Wax paper should be placed on top of the drawing and taped in place.

The students will then begin to construct one side of the box. They should place the
wood on the paper directly over the lines on the drawing representing the
corresponding structural elements of the side view. Pins may be used to anchor the
wood in place.

Then, the pieces should be glued together. Any excess glue that flows onto the wax
paper can be trimmed later after it has dried.

When the first side of the box has been constructed, the students can then repeat Steps
3 and 4 to construct the second side of the box.

When both sides of the box are dry, the students will then glue the sides together with
the additional 1.75" pieces of wood to form the completed box. They may want to
turn the structure on its side and apply pressure to it when it is drying. This can be
done by placing wax paper over the top side and then gently laying a flat object (such
as a light book) on top of the structure.

The entire model should be given ample time to dry. This will probably require
delaying the testing of the bridges until the next day.
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Testing the Models

Note: Any students located near the testing apparatus should wear safety goggles
during the testing of the structures.

The models will be tested by applying a load at their midspan.

1. Weigh each box structure prior to testing. (Not all the structures will weigh the same
amount because the weight will be highly dependent upon the amount of glue used.)

2. Slip the U-bolt through the holes in the endplate and screw the two nuts on the ends
of the bolt. The nuts should be secure but allow for plenty of room to slide the
structure through the U-bolt.

3. Slide the structure through the U-bolt so that the end plate is located at the midspan of
the structure. The fastening nuts should then be screwed on just far enough so that
they will not slip when bearing a load. Be careful not to crush the structure when
applying the U-bolt.

4. Place the box structure between two end supports, so that 17 of the structure is resting
on each support. Two desk tops spaced the appropriate distance apart make good end
supports.

5. Hook one end of the S-hook around the rounded base of the U-bolt.

6. Hook the empty plastic bucket to the other end of the S-hook. The setup should now
appear as in Figure 16. While slowly pouring the sand into the bucket using the 2.5
quart measuring pail, note any tell-tale signs (e.g., twisting, cracking, vertical
bending) that the bridge is approaching failure.

7. Continue pouring sand into the bucket until the wood breaks.

8. Using the scale, weigh the bucket, its contents, and the S-hook. Record this number.
The final weight the bridge was able to support is known as its ultimate strength.

0. Divide the ultimate strength of each bridge by the weight of each bridge. This will be
known as the bridge's performance ratio.
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Figure 16. Basic box structure testing setup.

QUESTIONS

1) Tabulate a list of each bridge's weight, ultimate strength and performance ratio, and compare
the construction and performance of each structure tested. Do you notice any particular
design attributes that contribute to the structure's sturdiness? For instance, did using a lot of
glue help the bridge support more weight? Did it increase the performance ratio?

2) How did your structure break? Did it break from shearing (i.e., did the end-plate of the bolt
simply snap though the pieces below it)? Twisting? Rotation? Joint failure? Why do you
think your structure broke in the manner that it did?
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3) How do you think you can improve the design of the basic box to make it bear more weight?
How do you think you can improve the design of the basic box to achieve a greater
performance ratio?

DISCUSSION:

Students who used a lot of glue may notice that their bridges were stronger. But they may also
notice that their performance ratios suffered from the added weight to the structure. Try to
identify any structures that failed because the joints were improperly glued. Compare the
performance of these structures to those that had heavily glued joints. It is important to find the
middle ground between a structure with strong joints and a structure with a light weight.

Some students who constructed well-built bridges may have had disappointing results because of
the existence of unseen flaws (such as cracks or pin holes) in their wood. When handing out the
wood for the next activity, give the students the opportunity to examine their wood and replace
any faulty pieces with unflawed wood.

If any of the designs were warped, the students may notice that their bridge twisted apart rather
than broke in two by shearing. This type of failure may be avoided by ensuring the wood is cut to
the proper lengths and glued together at right angles. Also, if the end plate of the U-bolt was not
centered properly on top of the structure, an eccentric loading may result, which can cause
twisting. Allowing the students to place the testing bolt on their own structures will make them
more aware of this possibility.

Some ways that the students can alter their design to achieve better results are discussed in
Activity 5.
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Activity 5: Improved Box
Bridge Structure

ACTIVITY TABLE

Teacher Prep Time 10 minutes reading; 20 minutes lab prep

Class Time 3 hours

Grade/Class 8-12 Advanced

Technology Lo Tech

. . . Science as inquiry

National Science Education Standards Identify problems for technological design
Design a product
Implement proposed design
Evaluate product

INTRODUCTION

In this hands-on activity, the students will again construct a rectangular box out of balsa wood
and glue. Each student (or group of students) will design a structure with a specified length of
20" and a width of 2", but the depth will be an open-ended design parameter. However, the total
depth of the bridge should not exceed 4" in order to accommodate the U-bracket testing
apparatus. Additionally, all other aspects of the design will be left up to the student. They can
add diagonal structural elements or include arch-type elements within the rectangular frame.
They can also laminate sections of the balsa wood together to enhance the strength of the
individual elements. Their only constraint will be that they must limit the amount of balsa wood
they use to the six 36" lengths.

Ideally, this activity will follow the Basic Box Structure Activity, and the students can apply the
knowledge they gained about construction techniques to design an improved structure. However,
this activity can also be performed without the benefit of the previous exercise.

The structures will then be tested in the same manner described above for the Basic Box. Again,
the performance of the structures will not be judged upon ultimate strength alone. Each of the
students’ structures should be weighed prior to testing, and the performance will be based upon a
combination of ultimate strength and structure weight, i.e., the performance ratio.
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OBJECTIVE

It is hoped that students will apply the lessons they learned in the previous activities to design
their structure. A classroom discussion should follow the performance testing to identify the
elements of the most successful designs.

BACKGROUND

The building of a bridge is composed of two main components: the designing (and planning) of
the bridge and the building (or construction) of the bridge. The design of the bridge determines
the general structure type and the geometric layout of its members to ensure an efficient and safe
design for a given loading condition (which is also called the service state). The contractors will
then take the engineering/architecture plans and actually build the structure.

Activity 4 helped the students identify some of the things that can go wrong in the construction

and testing phase of their bridge model. This activity will also do so; however, the design of the
students' structures will primarily determine their performance. It is hoped that the students will
consider the following design enhancements that can improve the overall structure performance:

a) Lamination of the main longitudinal members to take advantage of the effect of
increased member height, as shown in Activity 2C

b) Use of diagonal members to increase bending strength

C) Use of X-bracing in the cross-section of the structure to help reduce twisting
effects

d) Increase the overall height of the structure to take advantage of the effect of

increased member height, as shown in Activity 2C

e) Joint modifications, such as tapering or notching, to increase surface area of glued
connection
f) Employment of an arched-shaped or trapezoidal profile (instead of a rectangular

one) to reduce overall structure weight and increase efficiency

MATERIALS NEEDED:

Six 36" lengths of 1/8" square cross-section balsa wood
Carpenter's Glue
X-Acto Knife

Ruler or straight edge
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Long Pins

Drafting (or Graph) Paper — at least 22" long by 8"
Wax paper — same dimensions as drafting paper

4" long and 2.25" wide U-bolt with bracket and nuts
Light plastic painter's bucket

Play sand

Weighing scale

Safety goggles

SET UP

The instructor will need to allocate the wood, glue, pins, X-Acto knives, straight edges, wax
paper, and drafting paper to the students or groups of students. The rest of the materials will be
used for the in-class testing.

PROCEDURE

Drafting Exercise

The students should draw planar (two-dimensional) views of the structure they are going to
build. The gradations on the drafting (or graph) paper will help them ensure that the lines
representing the structural elements are drawn to the correct 1:1 scale. Generally, students may
want to draw two side views and one end view of the structure. Students should be aware of the
combined length of all members in their design to ensure that they do not exceed the allotted
amount of material.

Construction Exercise

(Given the length of time needed to complete this part of the activity, the instructor may want to
assign this task as a take-home assignment.)

Note: Students should wear safety goggles while cutting the balsa wood and care
should be taken so that they do not cut themselves with the X-Acto knife.

1. The students should cut the 36" balsa wood lengths into the appropriate number of
pieces, as dictated by their design.

2. Wax paper should be placed on top of the drawing and taped in place.
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3. The students will then begin to construct one side of the box. They should place the
wood on the paper directly over the lines on the drawing representing the
corresponding structural elements of the side view. Pins may be used to anchor the
wood in place.

4. Then, the pieces should be glued together. Any excess glue that flows onto the wax
paper can be trimmed later after it has dried.

5. When the first side of the box has been constructed, the students can then repeat Steps
3 and 4 to construct the second side of the box.

6. When both sides of the box are dry, the students will then glue the sides together with
the bracing elements they designed to form the completed box. They may want to
turn the structure on its side and apply pressure to it when it is drying. This can be
done by placing wax paper over the top side and then gently laying a flat object (such
as a light book) on top of the structure.

7. The entire model should be given ample time to dry.

Testing the Models

Note: Any students located near the testing apparatus should wear safety goggles
during the testing of the structures.

The models will be tested by applying a load at their midspan.
1. Weigh each box structure prior to testing. Record these values.

2. Slip the U-bolt through the holes in the endplate and screw the two nuts on the ends
of the bolt. The nuts should be secure but allow for plenty of room to slide the
structure through the U-bolt.

3. Slide the structure through the U-bolt so that the end plate is located at the midspan of
the structure. The fastening nuts should then be screwed on far enough so that they
will not slip when bearing a load.

4. Place the structure between two end supports, so that 1” of the structure is resting on
each support. Two desktops spaced the appropriate distance apart make good end
supports.

5. Hook one end of the S-hook around the rounded base of the U-bolt.

6. Hook the empty plastic bucket to the other end of the S-hook. The setup should now

appear as in Figure 16.

7. While slowly pouring the sand into the bucket, note any telltale signs (e.g., twisting,
cracking, vertical bending) that the bridge is approaching failure.
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8. Continue pouring sand into the bucket until the wood breaks.

9. Using the scale, weigh the bucket, its contents, and the S-hook. Record this number.
The final weight the bridge was able to support is known as its ultimate strength.

10. Divide the ultimate strength of each bridge by the weight of each bridge. This will be
known as the bridge's performance ratio.

QUESTIONS

1) Tabulate a list of each bridge's weight, ultimate strength and performance ratio and compare
the design, construction, and performance of each structure tested. Do you notice any
particular design attributes that contribute to the amount of weight the structure was able to
support? What design aspects resulted in high performance ratios?

2) How did your structure break? Did it break from shearing? Twisting? Rotation? Joint failure?
Why do you think your structure broke in the manner that it did?
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3) How do you think you can improve the design to make it bear more weight? How do you
think you can improve the design of the basic box to achieve a greater performance ratio?

DISCUSSION:

Students who used a lot of glue may notice that their bridges were stronger. But they may also
notice that their performance ratios suffered from the added weight to the structure. Try to
identify any structures that failed because the joints were improperly glued. Compare the
performance of these structures to those that had heavily glued joints. It is important to find the
middle ground between a structure with strong joints and a structure with a light weight.

Some students who constructed well-built bridges may have had disappointing results because of
the existence of unseen flaws (such as cracks or pin holes) in their wood. When handing out the
wood for the next activity, give the students the opportunity to examine their wood and replace
any faulty pieces with unflawed wood.

If any of the designs were warped, the students may notice that their bridge twisted apart rather
than broke in two by shearing. This type of failure may be avoided by ensuring the wood is cut to
the proper lengths and glued together at right angles. Also, if the end plate of the U-bolt was not
centered properly on top of the structure, an eccentric loading may result, which can cause
twisting. Allowing the students to place the testing bolt on their own structures will make them
more aware of this possibility.
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VOLUNTEER'S PAGE

A wide variety of volunteers from the transportation field can lend their expertise to discussions
arising from the activities contained in this module. The following are suggested topics
corresponding to each activity.

Activity 1, Structural Concepts: A structural engineer could give additional insight into the
ways bridges are designed and constructed. A historian could talk about the history of bridge
structures and discuss famous structural achievements and disasters. A volunteer from the
construction or construction management professions could provide detail about how bridges are
built in challenging settings, such as wide rivers or deep gorges.

Activity 2, Beam Me Up: A structural engineer, mechanical engineer or material scientist can
describe how materials are tested to quantify their mechanical properties. Any volunteer with an
applied science, mathematics or engineering background can discuss how empirical and
analytical mathematical equations describe behavior in the physical world.

Activity 3, Computer-Based Bridge Modeling: Any volunteer with experience in computer
modeling can describe how specific models have been used to predict the behavior of a wide
range of physical processes. Specifically, the limitations of and benefits gained from relatively
low-cost computational models can be discussed. Students could be made aware of the necessity
to calibrate models and evaluate their output in light of actual behavior witnessed through field
experiments and other observational methods.

Activities 4 & 5, Basic and Improved Box Bridge Structures: A volunteer from the
construction or construction management professions could relate the students work with balsa
wood to bridge construction using concrete and steel. A fest engineer can discuss the factors
which must be considered when evaluating structural materials. A material scientist can talk
about material defects and how they affect structural fracture and fatigue.
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